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Introducing the World of Illustrator
In This Chapter
▶ Getting a look at how graphic artists use Illustrator

▶ Becoming familiar with the Illustrator interface

▶ Noting some Mac and Windows differences

▶ Creating new documents

▶ Saving your artwork

▶ Printing Illustrator documents

▶ Bailing out of a document (and Illustrator itself)

The first time you run Illustrator, you’ll probably think that Adobe 

Intimidator would be a more appropriate name than Adobe Illustrator. The 

program’s dozens of tools, hundreds of commands, and more than 

30 panels can transform confident, secure individuals into 

drooling, confused, and frustrated drones.

The situation doesn’t have to be that way, of course. 

Sure, all that stuff is scary. Even more frightening 

to some is the prospect of facing the giant white 

nothingness of the Document window — the end-

less possibilities, the confusion over where to start. 

This chapter helps you get past that initial stage 

and move forward into the mystical state of eagerly 

awaiting (instead of fearing) each new feature and 

function.

From Humble Origins to Master 
of the Graphics Universe

As its box proudly proclaims, Adobe Illustrator is the “Industry Standard 

Graphics Software.” The software didn’t always enjoy that standing, though. 

Illustrator evolved from a geeky math experiment into the graphics power-

house it is today.
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10 Part I: Driving People Crazy — Illustrator’s Bum Rap 

A brief history of Illustrator
Until the mid-1980s, computer art was limited to blocky-looking video 

games, spheroid reflections, and the movie Tron. Then something happened 

to change all that (in addition to Jeff Bridges’ refusal to make a sequel) — 

namely, PostScript, a computer language created especially for printers. 

Adobe created PostScript specifically to help printers produce millions of 

teeny-tiny dots on the page, without running out of memory. (Graphics files 

were notoriously huge relative to the teeny-tiny computers of the day.)

In 1987, Adobe released Illustrator 1.1, which was designed primarily to be a 

front end for PostScript: that is, a way to make its capabilities actually usable. 

At that time, the concept of artwork scalable to any size without loss of qual-
ity (one world-beating advantage of creating art within Illustrator) was brand 

new. Illustrator gave companies the opportunity to have electronic versions 

of their logos that could be printed at any size.

In the 20-plus years since version 1.1, Adobe Illustrator has become the Web-

ready, giant application that it is today. Millions of people around the world 

use Illustrator and its thousands of features (big and small) meet a wide 

variety of graphics needs. Oddly enough, the one aspect of Illustrator that 

hasn’t changed is the perceived intimidation factor. Version 1.1 had several 

tools, many menu items, a neurosis-inducing Pen tool, Bézier curves, and that 

way-scary blank page when you started it up. The most recent version still 

has nearly every feature that 1.1 did and has added a staggering array of new 

features, but it still has that way-scary blank page. Illustrator 1.1 was a playful 

little kitten compared with the beast that is Illustrator CS4!

The new features in Illustrator CS4 include:

 ✓ Multiple Pages: Don’t search for “Multiple Pages” in the list of new 

Illustrator features when you’re looking at the official Adobe documen-

tation. In their infinite wisdom, they have named this feature “Multiple 

Artboards,” but you and I know the truth, so we’ll call it what it is: mul-

tiple pages in Illustrator, 

 ✓ Super-Smart Smart Guides: Little lines and hints that appear as you 

work, helping you to align your drawings automatically. Beware: After 

you start using them, you’ll never be able to go back to the, er, “dumb” 

Smart Guides from previous versions.

 ✓ Streamlined, Shiny User Interface: The first thing you’ll notice are those 

funny little tabs above your document windows. When you’re done 

being distracted by that, however, you’ll find that the panels and tools 

and control panel are all optimized to magically work just the way you 

expect them to, with automatically-resizing panels and options that exist 

only when it makes sense that they do. And did I mention it’s shiny?
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11 Chapter 1: Introducing the World of Illustrator

Illustrator’s place in the cosmos
Professional graphic artists have a Tools panel of programs that they use to 

create the books, magazines, newspapers, packaging, advertisements, and 

Web sites that you see every day. Any professional will tell you that you need 

the right tool for the job to do the job well. The right tools (in this case) are 

software products: drawing programs, paint programs, and products for 

page layout and Web-authoring. Drawing programs, such as Adobe Illustrator, 

are the best tools for creating crisp, professional-looking graphics (such as 

logos), working with creative type effects, and re-creating photographs from 

line drawings. Painting programs (often called image editing programs), such 

as Adobe Photoshop, provide tools to color-correct, retouch, and edit digital 

photographs and re-create “natural media” effects, such as hand-painting. 

Page layout programs, such as Adobe InDesign or QuarkXPress, enable you 

to combine graphics that you create in drawing and paint programs with text 

for print publishing. You can use Web-authoring tools (such as Macromedia 

Dreamweaver or Adobe GoLive) to combine graphics, text, sound, animation, 

and interactivity for presentation on the World Wide Web.

Although each tool performs a fairly specific (if wide-ranging) task, there is 

some crossover between applications. For example, Illustrator has some lim-

ited image editing capabilities, but very few people ever use them. Because 

you can edit images with complete control and freedom in Photoshop, why 

use the wrong tool for the job? InDesign enables you to run type along a 

curve, but Illustrator has so many tools for creative type effects that you’d be 

silly to do them anywhere else.

By using Illustrator on its own, you can create an astonishing variety of 

graphics and type effects. When you combine it with paint, page layout, 

video, and Web-authoring programs, you have the tools you need to create 

print and Web publications that match the quality of anything you see in the 

stands or on-screen today.

Illustrator is the de facto standard in graphics creation. Although there used 

to be several competing programs out there (FreeHand, which is now gone 

forever; and CorelDRAW, which stumbles on, somehow unaware that no one 

is paying attention), Illustrator is used more than 20 times as much as any 

competing products combined. This is mainly because it’s the gold standard 

in several ways, from feature breadth and depth to tight integration with other 

standard applications and formats, including Photoshop, Flash, and PDF.

Adobe has products in the other categories: Photoshop, InDesign, Flash, 

After Effects, and Dreamweaver. One benefit of using Illustrator is that it 

works very well (as you might expect) with the other Adobe products, most 

of which have a similar interface and way of working. If you know one Adobe 

product well, chances are that you’ll have an easy time of figuring out other 

Adobe products.

05_396568-ch01.indd   1105_396568-ch01.indd   11 9/22/08   9:35:15 PM9/22/08   9:35:15 PM



12 Part I: Driving People Crazy — Illustrator’s Bum Rap 

Illustrator excels at creating and editing artwork of all types. In fact, you 

can use Illustrator to create and edit nearly anything that didn’t start out 

as a photograph — and thanks to Live Trace, you can even do that! For 

more about the differences between photographs and artwork created with 

Illustrator, see Chapter 2.

Starting Up Illustrator and Revving It a Little
To get Illustrator running, double-click the application’s icon (Mac) or 

choose Illustrator from the Start menu (Windows). (The first method also 

works in Windows, if you’re a Mac user who happens to be using Windows. 

Don’t worry; I won’t tell a soul. Honest.)

The Illustrator startup process displays the splash screen — an image to look 

at while the program is cranking up. It’s a lovely shade of orange, quite like 

the sunset that has set on Illustrator’s competitors over the years. And you 

can’t miss the giant Ai, which stands (of course) for Adobe Illustrator (and 

also happens to be the two-letter file extension of native Illustrator files). 

As Illustrator continues the startup process, the block of orange disappears 

and is replaced by the Welcome screen, as shown in Figure 1-1. The Welcome 

screen gives the following options to start using Illustrator.

 ✓ Open a Recent Item: Here, you’ll see a list of the most recent files 

you’ve opened up in Adobe Illustrator. This is a great way to get right 

back to work where you last left off, without having to search for your 

files. Note: At the bottom of the list is an Open folder icon; clicking that 

icon brings up a standard Open dialog box, which you can use to navi-

gate to any file you want.

 ✓ Create New: Here is a list of common file structures to get you started. 

You can also click the From Template folder to load a predefined tem-

plate for items such as business cards, CD labels, and other stuff you 

probably don’t want to have to start making from scratch. Clicking any 

of the predefined file structures (such as Print Document) displays the 

New Document dialog box, as shown in Figure 1-2.

 ✓ Getting Started, New Features, Resources, and Illustrator Exchange: 

Technically, this part of the Welcome screen doesn’t get you started in 

Illustrator, but it can help you get started thinking about how you can 

best use Illustrator. Each of these items is a link that takes you to vari-

ous Adobe-sponsored Web pages with useful information. Good when 

you’re really really bored.
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13 Chapter 1: Introducing the World of Illustrator

 

 Figure 1-1: Start at the Welcome screen.

 

 Figure 1-2: The New Document dialog box.
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If you mark the Don’t Show Again check box, this handy Welcome screen will 

never bother you again. But because the Welcome screen is actually pretty 

handy, don’t check that box! If (say, in a fit of rebellion) you do dismiss 

the Welcome screen “forever,” you can get it back at any time by choosing 

Help➪Welcome Screen from the main menu. And then you should clear the 

box, like I mentioned, so this doesn’t happen again.

Before you start a new document, you have to answer a few questions in 

the New Document dialog box about the name, page size, units of measure-

ment, orientation, and color mode that you plan to use. If you’ve gotten to 

this dialog box via one of the links under Create New on the Welcome screen, 

it will be prepopulated with the appropriate values, which you can simply 

accept by clicking OK. The next few sections discuss the various fields and 

options in the New Document dialog box.

What’s in a Name (field)?
You can give your new document a name in the Name field. If you don’t, 

Illustrator names it Untitled-1, and every new document you create is titled 

sequentially — Untitled-2, Untitled-3, and so on, until you quit the program. 

When you relaunch, you’ll be right back at Untitled-1. If you don’t give a name 

to the new document, you get another chance when you save it. The advan-

tage to naming your document is clarity: If you ignore my advice and accumu-

late a bunch of unsaved files (not recommended!), you can’t tell them apart. 

Besides, when you see the true name of the document in the title bar (at the 

top of the document), you don’t forget what you’re doing.

Artboard options
You can set up a document so that it has more than one artboard right from 

the start by increasing the Artboard number to anything greater than “1.” 

After you do that, a bunch of other options become available, such as the 

space between artboards, how they’re laid out, and the number of columns 

you’d like the artboards to appear in. Most of the time, however, you’ll just 

leave this at 1 and pretend you never even saw these settings.

Page size, units, and orientation
You set your page size by choosing a predefined size from the Size drop-

down menu or by typing values into the Height and Width fields. Your page 

size truly matters only when you’re printing your document directly out 

of Illustrator. Otherwise, it just exists as a point of reference — a guide to 

show you how far things are apart from each other. One great thing about 
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15 Chapter 1: Introducing the World of Illustrator

Illustrator: For the most part, size doesn’t matter (no, really). When you 

create graphics for the Web, you can determine the size of the graphic when 

you save it. When you’re creating graphics for print, most of the time, you’ll 

be creating graphics to be imported into page layout applications, such as 

QuarkXPress or InDesign. In the latter case, although it’s always best to size 

your image in Illustrator, you can scale the graphic to the size you need it in 

your page layout. In either case, the Web browser or page layout application 

recognizes your Illustrator drawing, ignoring the page size.

Page size is good for two things: proofing and conceptualization. Often, you’ll 

want to print your artwork on paper directly from Illustrator to get an idea 

of what it looks like. In this case, set the Size to the size of paper loaded in 

your printer. While creating graphics, keep in mind the size of the page or 

browser window that you’re creating for: In this case, set the Height and 

Width to whatever the target output is. For example, if you’re creating for 

the Web, you might want to set the size to 1024 pixels x 768 pixels, which is 

a fairly standard minimum size for computer screens, to help you visualize 

the final artwork. Actually, you can change the size of the artwork to be any-

thing you want, at any time, and that’s one of the great things about creating 

in Illustrator. In addition, you can change the “bleed” amount of a document, 

which is how much stuff that doesn’t fit on your artboard will still print. This 

is great for when you have backgrounds that go to the edges of the page. 

(Having this extra “bleed” area results in better looking edges.)

 By default, Illustrator measures image size in points (1 point [pt] = 1⁄72 inch). 

If that unit of measurement is unfamiliar to you, be sure to select a different 

unit from the Units drop-down menu in the New Document dialog box. Your 

ruler also changes units (when you choose View➪Show Rulers) to the type 

you selected. And although it won’t change the ruler units, you can also type 

the unit of measurement along with the number when you specify values for 

page size in the Height and Width fields. When you open a new document, 

it comes up showing a width in points: say, for instance, 612 pt. If you want 

to specify a width of 10 inches or 30 centimeters, just type (respectively) 

10 in or 30 cm in the Width field. If you don’t know the standard abbreviation 

for a unit of measurement, you can type the whole word out (for example, 

10 inches or 30 centimeters). Illustrator understands what you mean and 

does the conversion for you. And it will do so wherever you enter a unit 

of measurement, not only in the New Document dialog box. Smart, very 

smart!

CMYK or RGB?
CMYK or RGB? In Illustrator, this question is a bit more significant than the 

ubiquitous question, “Paper or plastic?” To understand why you have to 
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answer Illustrator’s question, you need a little more history and some tech-

nobabble. (Sorry, I’ll try to keep this brief.)

Illustrator has been around for a long time, back when putting color images 

on the Web was impossible, and interactive multimedia was little more than 

a buzzword. In those days, the main reason for creating documents in color 

on the computer was so you could print them in color. Color printing almost 

always uses a CMYK process — for cyan, magenta, yellow, and black inks 

(the k stands for black because RGB has dibs on b, which stands for blue). 

These four colors, blended in different amounts, produce the full range 

of colors you see in printed material. So back then, Illustrator used only 

CMYK colors because nobody needed to do anything in color besides 

print.

Then along came interactive multimedia — in effect, the “lights, camera, 

sound, and action” for computer users. Shortly after that came the Web. 

Because images used for multimedia and the Web appear only on the com-

puter screen, a need emerged for RGB images. So what’s RGB, already? Okay, 

I’m getting to that: Computer screens create the colors you see by using elec-

trons to make a coating of phosphors glow red, green, or blue (hence, RGB) 

in different intensities. If you’re creating content for multimedia applications 

or for the Web, you need RGB images that look good on-screen. You probably 

don’t give two hoots about CMYK. So Illustrator, trying to please everyone, 

added the capability to create colors in RGB.

Unfortunately, this new feature didn’t quite please everyone. In fact, it 

upset some people quite a lot and left a wake of money wasted, deadlines 

blown, marriages ruined, lives lost, and empires crushed. (Well, okay, 

that’s a little exaggeration, but only a little.) CMYK and RGB just didn’t get 

along.

Printing in color meant using the standard four-color printing process: 

Every image had its own percentage of cyan, magenta, yellow, and black, 

so four sets of films were made (one for each of those colors), and the 

final printed image combined the colors. Each set consisted of only four 

single-color plates (C, M, Y, and K), and that’s all you’d expect to print 

out. However, if your Illustrator file contained any RGB elements (even a 

few pixels’ worth), you had big trouble: Three additional films would print 

out — frequently at a cost of $100 or more per film — for every page that 

contained any RGB colors. If you weren’t paying attention, one mistake like 

that could cost thousands of dollars. And a lot of people weren’t paying 

attention because they’d never had to worry about RGB colors in an 

Illustrator file before. (You can bet they did after that!) To prevent this sort 
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17 Chapter 1: Introducing the World of Illustrator

of uproar from happening again, Adobe wisely removed the capability to 

combine CMYK and RGB colors in the same document. That’s why you have 

to specify CMYK or RGB before you start a new document. Sure, it’s a hassle, 

but you’re so much better off having this hassle now rather than spending 

money for it later!

So which do you choose, CMYK or RGB? You might think it safe to assume 

that RGB is for multimedia or the Web and CMYK is for print. Okay, that’s a 

safe assumption, but not necessarily the best assumption. If you aren’t sure 

where you’re going to output, pick RGB. You can always change to CMYK 

later if you’re required to, and you’ll be able to print directly to color printers 

just fine that way.

For the sake of your creativity, choose RGB when

 ✓ You’re creating for the Web or for multimedia. In this situation, you’re 

always creating work that’s going to be viewed in RGB, and you have no 

practical reason whatever to use CMYK.

 ✓ You’re creating for print BUT do not need precise CMYK colors. If 

you don’t have to specify exact CMYK values while you work, choose 

RGB. (You can convert to CMYK by using the File➪Document Color 

Mode command before you print. Just don’t forget to, okay?) I know that 

approach sounds like asking for trouble, but I can give you three good 

reasons for using RGB this way:

 • Some of Illustrator’s coolest features (including many Photoshop filter 
effects) work only with RGB color.

 • When you work in RGB, you can use the full range of colors — mil-
lions of them — that are possible on the computer. CMYK supports 

only mere thousands of colors. If you’re creating content for both 

print and the Web, creating the image in RGB gives you the maxi-

mum color range possible in both CMYK and RGB.

 • Some desktop inkjet color printers print well in RGB. For example, 

Epson six-color printers print a wider range (gamut) of colors in 

RGB than in CMYK.

For the sake of accuracy, choose CMYK when

 ✓ You need precise CMYK colors. Some artists who create for print use a 

swatch book of printed CMYK colors. They use only the specific CMYK 

colors they see in the book because they feel (and rightly so) that this 

is the only way to get a good idea of what that color will look like when 
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it finally prints. If your designs have to meet such specific requirements, 

you should always work in CMYK. Some companies specify the exact 

CMYK colors they want in their publications. If you’re working on a 

project for one of those companies, use CMYK.

 ✓ You’re creating for grayscale or black-and-white print. In RGB, shades 

of gray exist by default as blends of red, green, and blue. If you’re print-

ing with black ink, this blending is a hassle because you always have 

to work with three colors instead of one. In CMYK, however, you can 

create shades of gray as percentages of black ink, ignoring all other 

colors (which you might as well do if they won’t be visible anyway).

After you answer the three magic New Document questions (name, page 

specs, and color choice), click OK and behold: A blank page opens, inviting 

you to realize your creative potential, as shown in Figure 1-3. You’re ready 

to start illustrating. If blank-page syndrome doesn’t faze you and you want to 

dig into the good stuff right away, thumb over to Chapter 2.

Of course, you can also mess around with the Raster Effects setting and 

preview mode, but doing so will make your life difficult. My advice is to keep 

these as the default settings.

 

 Figure 1-3: Your first blank page. Awe inspiring, isn’t it?
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Exploring the Illustrator Workspace
Between figuring out what the 250+ menu 

items actually do and rearranging panels 

(until you have a tiny little area on your docu-

ment in which you can actually work), you 

might find the Illustrator environment a bit 

daunting. (If you do, you’re far from alone.) 

And that’s after the good people at Adobe 

took out an entire menu from the product for 

CS4 (the Filter menu, whose time has long 

past). The next sections are an overview of 

all the stuff that’s preventing you from get-

ting any work done. (That stuff is what the 

geeks call the UI.)

Illustrator tool time
The Illustrator Tools panel (that alien artifact 

in Figure 1-4) is the place where most people 

start when they use Illustrator. After show-

ing you a whole bunch of tools, some odd-

looking buttons, and a gang of giant square 

things, the Tools panel (as shown in Figure 

1-4) pretends that’s all there is to it. Actually, 

the Tools panel has over 50 hidden tools. 

Select most tools in Illustrator by clicking 

(once) the tool you want in the Tools panel. 

The cursor then changes to either something 

that looks like the tool, or in the case of spe-

cial tools (Rectangle, Ellipse, and others), a 

cross-hair cursor.

The tools live in toolslots, which are subdivi-

sions within the Tools panel. Many toolslots 

contain more than one tool, as indicated by a 

small black arrow in the bottom-right corner 

of the toolslot. To access a hidden tool, click 

and hold the mouse pointer on a tool in its 

toolslot. You then see a bunch of other (usu-

ally related) tools materialize by the toolslot 

that you clicked (as shown with the Pen tool 

in Figure 1-4). Use those other tools by drag-

ging to the tool you want to use and then 

releasing the mouse button.

Figure 1-4: The Illustrator Tools panel.
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 Drag over to the little bar to the right of the hidden tools in the toolslot and 

let go of the mouse button when the little bar becomes highlighted. A sepa-

rate little window appears, containing all the tools from the toolslot. You can 

drag this window off the Tools panel and place it anywhere on the screen. 

This procedure can save your sanity if you’re constantly switching between 

two tools that share a toolslot, such as the Pen tool and the Convert 

Direction Point tool. To get rid of this toolslot window, click the tiny white 

Close box (Mac) in its upper-left corner or the X (Windows).

 When you pause the mouse pointer over any tool, the name of the tool 

appears, followed by a letter. Well, no, the letters aren’t grades given to the 

tools for their usefulness; the letters let you know which keys to press if you 

want quick access to the tools. (For instance, press the P key on your key-

board to get the Pen tool or R to get the Rotate tool.)

As you gaze at the Tools panel, notice that it doesn’t have a Close or Expand 

box along its top. One possible explanation for this is that you go to the 

Tools panel for just about everything you do in Illustrator, and it’s almost 

impossible to work without it. If you really want to, though, you can hide 

the Tools panel by selecting Tools from the Window menu at the top of the 

screen. To bring back the Tools panel, go to the Window menu again and 

select Tools.

 You can hide the Tools panel temporarily — along with your other panels — 

by pressing the Tab key. Although this feature can be unsettling if you don’t 

know about it (if you hit the Tab key by accident, everything disappears except 

your graphics and the menu bar!), it’s still mighty useful, especially if you’re 

working on a small computer screen. You can work with everything hidden, 

press the Tab key when you need to, select the tool or panel item you need, 

and then get back to work unfettered by the things you aren’t using. This 

approach is a lot faster than selecting to show or hide the Tools panel from 

the Window menu whenever you want to do something different.

Panels to suit any artist
Illustrator has a ton of panels in addition to the Tools panel. You might 

think of a panel as something more closely associated with a painter than 

an illustrator, but nonetheless, Illustrator has about 30 of them. Like with a 

painter’s palette that holds the paints she uses most, an Illustrator panel pro-

vides quick access to the most frequently used commands and features. The 

contents of panels are organized according to what they do. For example, 

the Character panel contains commands to format individual pieces or big 

chunks of text, and you use the Color panel to create and change colors. 

Although Illustrator has dozens of panels, you rarely need to have them all 

open at once. When entering text, for example, you want the Character panel 
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21 Chapter 1: Introducing the World of Illustrator

open, but you probably don’t need the Gradient 

panel open because the Gradient panel controls 

only, um, gradients. (Go figure.)

You open a panel by choosing it as a menu item. 

These all live in the Window menu (such as 

Window➪Colors). To close a panel, click the X in 

its upper-right corner.

 Fortunately, Illustrator can both tab and dock 

panels to keep them more organized, giving you 

a wee bit of space in which you can actually draw 

and edit your artwork. Tabbing lets you stack 

panels in one area so they overlap like index 

cards. Docking connects the top of one panel to 

the bottom of another so that both panels are 

visible but take up as little space as possible.

By default, Illustrator displays the panels shown 

in Figure 1-5, docked along the right edge of 

the screen. Notice that some of the panels are 

grouped into sets and offer you several tabs. (For 

instance, the Stroke, Gradient, and Transparency 

panels are tabbed together in one set.) Initially, 

you see only the Stroke panel; the Gradient and 

Transparency panels are hidden behind the 

Stroke panel. To see either of those panels, click 

the tab for the one you want to view.

You can combine panels by any method that you 

feel works for you. To move a panel from one set 

to another, click and drag that panel’s tab from 

one set into another — or out by itself (which 

creates a new tab group). Illustrator doesn’t limit 

you; you can combine any panel with any set. 

You can even put all of Illustrator’s panels into 

one set if you really want to. I don’t advise doing 

so, though, because the tabs would all overlap so 

you couldn’t tell what’s what.

Another way to use panels is to reduce them to 

their icon view by clicking the double triangle 

at the top of the stack of docked panels. Doing 

this results in a column of very nice looking 

icons, which initially have little (if any) meaning Figure 1-5: The default set 
of panels when you start 
Illustrator.
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to you, as shown in Figure 1-6. (The 

Appearance panel here is temporar-

ily showing because I clicked its 

icon.) Clicking an icon displays its 

associated panel, allowing you to 

make changes to various settings; as 

soon as you’re done in that panel, 

it snaps closed, leaving you a ton of 

valuable screen space.

Many Illustrator panels have their 

own menus, which pop up when you 

click the triangle in the upper-right 

corner of the panel, as shown in 

Figure 1-7.

Items in the panels’ pop-up menus 

relate specifically to each panel. This 

makes them easy to ignore and easy 

to figure out — after you master the 

individual panel, that is.

Menus with the finest 
cuisine
Illustrator menus are organized fairly 

well. Some menus are immediately 

obvious. For example, you find com-

mands having to do with type under 

the Type menu, and commands 

for viewing your document under 

the View menu. Other menus are a 

little less intuitive and make sense 

only after you start using them. For 

instance, after you realize that any 
one on-screen “thing” in Illustrator is 
an object, you discover that items in 

the Object menu relate to objects. 

Other menus take a little more work 

and experimentation to understand. 

Believe it or not, all these menus are 

arranged to make figuring out and 

using Illustrator as easy as possible.

Figure 1-6: The default set of panels in icon 
view.

Figure 1-7: Panels also have their own menus.
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To use an item in a menu, drag down 

to that item and release. Something 

should happen when you do that 

(no explosions or tsunamis, as far as 

I know), depending on which menu 

item you select. Even the way a menu 

item appears on a menu can be a 

handy tip. For example, consider the 

following characteristics:

 ✓ Submenus: Many of Illustrator’s 

menus have several submenus 

in them, indicated by a little 

triangle to the right of the menu 

item. To access a menu item in a 

submenu, drag down to the title 

of the submenu and then over 

to the item you want to use. 

(See Figure 1-8.)

 ✓ Keyboard commands: Most 

menu items in Illustrator have 

keyboard shortcuts (key combi-

nations listed at the right) that 

can activate them.

 ✓ More info needed: An ellipsis 

(. . .) indicates that when you 

click the item, a dialog box 

appears, requesting additional 

input from you.

 ✓ Unavailable commands: A grayed-out menu item means Illustrator 

won’t let you do anything with that item just now.

Mac and Windows issues spring eternal
Okay, I know some loyalties in this area are fierce. Can’t we all just get along 

for a while? Regardless of which system you use or like, you work in Illustrator 

pretty much the same way. A few small differences are important enough to 

mention, however, especially if you jump between the two systems:

 ✓ The .ai extension: Windows users often need filename extensions 

after their filenames or the system refuses to look at the files. The 

Illustrator file extension is .ai. That’s right, as in aieee! but without the 

eee! Most file types (on Windows systems) have three-letter extensions; 

Figure 1-8: The Path submenu in the Object 
menu.
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Illustrator uses two. Windows folks should save Illustrator documents 

with the .ai extension for maximum compatibility with all flavors of 

Windows. Having the wrong extension on the file can cause problems. If 

you were to put .aif on there, for example, Windows would try to open 

the file as a sound file, fail, and give you an error message!

  Windows users are accustomed to using two- and three-letter filename 

extensions. Mac users don’t have to, but they really should get in the 

habit of doing so. For starters, that keeps the peace when you send 

files and lets you instantly identify what the file is. Illustrator lets you 

save files in an alphabet soup of file formats, such as PDF (.pdf), TIFF 

(.tif), EPS (.eps), or JPEG (.jpg). Each of these formats has its own 

unique properties and purposes. When you see .eps on a file, chances 

are good that it’s a graphic created for use in a page layout program. 

When you see .gif, you know it’s a graphic created for display on the 

Web. File extensions can tell you a lot about your files even before you 

open them.

 ✓ Right-click versus Control-click: 

While in Illustrator, Windows 

users can right-click most places 

in Illustrator to display a contex-

tual menu (see Figure 1-9). Mac 

users who don’t have a right 

mouse button can press the 

Control key while clicking the 

mouse button. Contextual menus 

(clever creatures!) are context-

sensitive: They recognize what 

the mouse is near when you 

click and give you options you 

can apply. For example:

 • Control-click (or right-

click) the Ruler, and a 

contextual menu shows 

up, offering to help you 

change the Ruler’s unit of 

measurement.

 • Control-click (or right-

click) text, and you can 

change the font, size, and 

a slew of other options.

 • Click a path, and up come the options related to paths, and so on.

  All the items found in contextual menus appear in the regular menus, 

too, so you never really have to use contextual menus. They’re among 

those little luxuries (like a steering wheel–warmer on a cold day) that 

make Illustrator so nice to use.

Figure 1-9: A contextual menu appears when you 
right-click (Windows) or Control-click (Mac).
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Defining the Document Area
Illustrator uses a traditional art board as a metaphor; it’s what you see when 

you create a new file (as shown in Figure 1-10). You have the page you’re 

working on (the Artboard), and the table the page sits on (the Scratch area, 
which traditional artists will recognize as a Pasteboard). When you create a 

new document, the Artboard appears as a rectangle in the middle of a white 

expanse. The actual size and shape of the Artboard depends on what you 

enter for height and width when you create a new document.

 

Artboard

Scratch Area

  Figure 1-10: The Artboard and the Scratch area: the first two rather boring elements you meet 
when you create a new Illustrator file.
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The Artboard serves as a guide to show how large your artwork is (relative 

to the page size you chose when you created the document). Many people 

find it easier to create with a specific page size in mind. If you come from a 

traditional graphic arts background, you might find the idea of an Artboard 

and Pasteboard (or Scratch area) reassuring. You can create elements and 

leave them in the Scratch area, ready for you to grab and add to the artwork 

you’re creating on the Artboard. As to how the Artboard affects your art — 

well, it doesn’t. It’s only a guide to help you get your bearings. Elements in 

the Scratch area still print if you print to large enough paper. If you save your 

Illustrator artwork as an EPS (Encapsulated PostScript) to bring it into a page 

layout program (or as a GIF to use on the Web), anything in the Scratch area 

is saved with it.

 If you don’t find the Artboard useful as a guide, you can hide it altogether by 

choosing View➪Hide Artboard.

For printing a document, you might find the Page Tiling feature a little more 

significant than the Artboard. Illustrator smartly recognizes the printer that 

your document is selected to print to and creates a Page Tile (a rectangle), 

which is the size and shape of the largest area that the selected printer 

can print. You can recognize the Page Tiling feature by a thin, dotted line 

that appears just inside the Artboard if you set page size to the size of your 

printer paper.

Most printers show a printable area slightly smaller than the page size. 

Anything outside these guides doesn’t print. Even so, remember that this 

guide is based on your printer; what’s inside someone else’s printable area 

might not be the same.

Opening Existing Documents
To open any existing Illustrator document, choose File➪Open from the 

main menu and then select the document you want (using the Windows 

Open dialog box shown in Figure 1-11; Mac dialog boxes look a little 

different).

Another way to open a document is by double-clicking the file itself. If you 

double-click an Illustrator file when Illustrator isn’t running, the program 

launches for you automatically. (Glad it’s not a missile.)
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 Figure 1-11: Use the Open dialog box to select the file you want to open.

Viewing Illustrator Documents
Illustrator provides versatile options for viewing documents, including con-

trols for zooming, scrolling, and hiding (or showing) certain document fea-

tures. You can zoom to the smallest areas of your artwork and make changes 

so minute that they aren’t visible to the human eye (and maybe feel better 

knowing that your graphic is microscopically perfect). Or, to get a good feel 

for your artwork’s effect in the real world, view your document at the actual 

size it prints. Or you can view your on-screen objects as their “skeletons” of 

essential points and paths, with no strokes or colors to distract you from the 

true essence of your artwork. A view of any phase is available, from points-

and-paths to perfect printout. Bottom line: You have to see what you’re doing 

to know what you’re doing. Illustrator offers that capability.
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Zooming in and out of artwork
You can view your artwork at actual size (approximately its size when it 

prints), much larger, or much smaller. Changing the zoom amount changes 

only the image’s on-screen appearance — not the image’s actual size, how it 

prints, or its appearance in another application. Zooming is like using binocu-

lars to watch a neighbor violate the bylaws of the homeowners’ association. 

Those unapproved maple saplings (and the sap who’s planting them) don’t 

actually change size; you just zoom in on them from a discreet distance.

The Zoom tool
  The Zoom tool is the magnifying glass at the bottom of the Tools panel. When 

you click the Zoom tool and move it over the document, a plus sign appears 

in the center of the magnifying glass. Clicking the Zoom tool makes the 

details of your artwork appear larger in the document window. You can click 

until you zoom in to 6,400 percent (64 times larger than actual size). Note: If 

you print while zoomed in, the image still prints at actual size. Figure 1-12 

shows a document viewed at actual size and zoomed in to 400 percent.

 

 Figure 1-12: Two views of the artwork: actual size and zoomed to 400 percent. 

The Zoom tool is actually two tools in one. When you hold down the Option 

key (Alt on Windows), the magnifying glass contains a minus sign. Holding 

down the Alt or Option key and clicking your image with the Zoom tool 

causes your image to appear smaller. You can zoom out as far as 3.13 percent 

(where everything is really tiny). Figure 1-13 shows the art from Figure 1-12 as 

it would look at 25 percent of its actual size.

05_396568-ch01.indd   2805_396568-ch01.indd   28 9/22/08   9:35:21 PM9/22/08   9:35:21 PM



29 Chapter 1: Introducing the World of Illustrator

 

 Figure 1-13: The artwork from Figure 1-12 at 25 percent of its actual size.

Speed zoom ahead
Zooming is something Illustrator users do often enough to warrant the multitude 

of keyboard commands associated with this function. In order of usefulness, the 

following items represent some of the most useful speed-zoom techniques:

 ✓ Use any tool to Zoom In. Press Ô+spacebar on a Mac (Ctrl+spacebar 

on Windows), and the tool you’re using changes to the magnifying glass 

with a plus sign in it. Click the area where you want to zoom in. After 

you release the keys, the Zoom tool switches back to the tool you were 

previously using. This shortcut is really handy.

 ✓ Use any tool to Zoom Out. Press Ô+Option+spacebar on a Mac 

(Ctrl+Alt+spacebar in Windows), and the tool you’re using changes to 

the magnifying glass with a minus sign in it. Click the image to zoom out. 
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After you release the keys, the Zoom tool switches back to the tool you 

were using. This shortcut is as handy as the temporary Zoom In tool.

 ✓ Go to Actual Size: Press Ô+1 on a Mac (Ctrl+1 in Windows) to return to 

actual size. You can also double-click the Zoom tool to do this.

 ✓ Go to Fit In Window view: Press Ô+0 on a Mac (Ctrl+0 in Windows) to 

zoom to the level at which your page fits into the window. You can also 

double-click the Hand tool to do this.

 ✓ Zoom in and out. Press Ô++ (plus) on a Mac (Ctrl++ [plus] in Windows) 

to zoom in one level or Ô+– [minus] on a Mac (Ctrl+– [minus] in 

Windows) to zoom out one level.

 ✓ Activate the Zoom In tool. Press Z to change to the Zoom In tool. If you 

actually read to the bottom of this list, geekiness from someone you know 

is starting to rub off on you. I strongly advise taking a few days off — away 

from your computer (and from said geek).

 ✓ While Zooming: Press the spacebar to move around the current mar-

quee (the dotted lines).

Scrolling around your document
You can use the scroll bars to move around your document, but they limit 

you to moving horizontally or vertically — and only one of those directions 

at a time. If you’re really cool (and you know you are), you can use the Hand 

tool to move around your document in any direction.

To use the Hand tool, choose it from the Tools panel. Then click and drag 

anywhere in the document. The artwork moves in the direction you drag. 

At first, this action might seem slightly awkward — ah! but power corrupts. 

After a few minutes of pushing your art around, you’ll never want to go back 

to those nasty scroll bars.

 You can use any tool as the Hand tool. To change a tool into the Hand tool, 

hold down the spacebar while you click the tool. Then click and drag just 

as you would with the Hand tool. Let go of the spacebar, and the tool you 

were using returns to its original form. This trick works with any tool except 

the Text tool. If you have the Text tool active, press Ô+spacebar on a Mac 

(Ctrl+spacebar on Windows).

Looking at the guts of your artwork
Typically, what you see in your Document window is pretty much what’s 

going to print (the view in Preview mode). However, what you see isn’t what 

the printer and Illustrator look at. Instead, they see all your Illustrator art-

work and objects as a series of outlines, placed images, and text (the view 

in Outline mode). If you want to view your document in this skeletal form, 

choose View➪Outline. Outline mode is a great diagnostic tool: It helps you 
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understand how a document was made. Figure 1-14 shows artwork in both 

Preview and Outline modes. Outline mode also makes it easier to select 

objects that are very close together.

 

 Figure 1-14: Art in Preview mode and Outline mode.

Notice that in Preview mode, things like the scribbly swashes between the 

numbered cities and the squiggles and circles don’t show up. That’s because 

those are all Illustrator Effects, which aren’t objects that are defined by paths 

and lines and points and such, but instead are applied to different objects. 

You can learn a lot about documents by viewing them this way.

Using Templates
Few things in life are as frightening as a blank page staring you down. 

Knowing this, the good folks at Adobe have supplied hundreds of templates 

to get you started quickly and easily. Templates, such as the filmy one shown 

in Figure 1-15, provide you with a stylish yet fully customizable starting point. 

Because you can change so much in each template, from colors to fonts to 

objects, your use of a template is sure to be different than your buddy Larry’s 

use of it. And, as evidenced by his questionable wardrobe, Larry has abso-

lutely no design sense whatsoever.
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To use a template in Illustrator, select the From Template option (under 

Create New) in the Welcome screen that I talk about earlier in the chapter, or 

choose File➪New from Template. The template opens up as an untitled docu-

ment. Don’t be concerned about writing over the template; you’re actually 

opening a copy of the original file.

 

 Figure 1-15: A template for a stylin’ postcard.
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Saving Illustrator Documents
The instant you accomplish something you like, you should save it. And you 

should save every few minutes, even if you haven’t done something you like. 

If you don’t, you lose all the work and have to re-create it if you crash, acci-

dentally quit, or accidentally shut off the power supply to your computer. 

Unlike applications such as Microsoft Word or Adobe InDesign, Illustrator 

has no auto-save feature. Anything you don’t save is lost. Just remember that 

old TLA (three-letter acronym), SOS: Save Often, Silly! Saving takes only a 

second, and it saves not only your artwork but also your time and sanity.

To save a document, choose File➪Save. If you haven’t yet saved the document, 

the Save As dialog box (as shown in Figure 1-16) appears. Reward its prompt-

ness by naming your file something appropriate, witty, and deep. Or type 

something hurried-but-meaningful, such as gasdfoiu or jkl23, so you can chal-

lenge yourself later to figure out what that @#*! document is. (Just kidding.)

 

 Figure 1-16: Name your masterpiece in the Save As dialog box.
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If you’ve already saved your document, the Save command updates the 

existing file. If you’re not sure whether you previously saved a document, 

look at the title bar. If it reads Untitled-1, you probably haven’t saved. (Only 

someone with a creepy sense of humor would pick Untitled-1 as a title just 

to befuddle the rest of us.) Illustrator is incredibly smart, so much so that 

it’s unsettling when it comes to saving files. Whenever you make a change, a 

little asterisk (*) appears to the right of your file name, telling you that you 

haven’t saved the files since you made changes. As soon as you smack good 

ol’ Ô+S on a Mac (Ctrl+S on Windows), the asterisk goes away.

Changing Your Mind
One of Illustrator’s most powerful features is likely strikingly familiar: the 

Edit➪Undo command that gives you a way to take back the goof you just 

made. And in Illustrator, choosing Edit➪Undo can be a multiple undo, 

making you the Master of Time! You can take your artwork back through 

time, step by step, all the way to when you first opened the document! If 

you make a mistake (or several), just choose Edit➪Undo (or press Ô+Z on 

a Mac or Ctrl+Z on Windows) repeatedly until you get back to the way things 

were before they went so wrong. To redo the last thing you undid, choose 

Edit➪Redo (or press Ô+Shift+Z on a Mac or Ctrl+Shift+Z on Windows). 

(A time machine with a reverse gear — way cool.)

Imagine creating with wild abandon — moving points, changing colors and 

line thicknesses, and deleting paths — because in Illustrator, you can change 

your mind after the fact. Think of what you could obliterate from time: the 

misplaced stroke that looks like a bad tattoo, the missed goal that kept your 

team from the playoffs, the blind date that went so horribly wrong. Well, 

okay, it only works in Illustrator. At least it works somewhere.

You can take a graphic back to the way it was when you first opened it, with 

one exception: If you close a file and then reopen it, you can’t go back to 

anything you did before you closed the file. You can, however, save a file and 

then go back to things that happened before you saved it — if you left the file 

open after you saved it. In that case, the only thing that can’t be undone is 

the Save command: You still have a file on your hard drive that exists exactly 

as it did when you hit Save. This method can be useful if you have to create 

multiple revisions of the same document.

Printing Illustrator Documents
If your computer is connected to a printer, you can print just about anything 

you create in Illustrator. Before you print, however, make sure that your 

artwork is within the Page Tiling boundaries (that dotted gray rectangle that 

shows up when you choose View➪Show Page Tiling). Only items within these 
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boundaries print. The dotted lines on the page indicate the trim area; if your 

image is outside the dotted lines, it won’t print.

To print your artwork, choose File➪Print. The Print dialog box appears (see 

Figure 1-17). Click OK; soon a sheet of paper emerges from your printer with 

your artwork on it.

 

 Figure 1-17: The Print dialog box has more options than Illustrator 1.1 
 had in the entire program.

Closing Documents and Quitting Illustrator
To close an Illustrator document, choose File➪Close. The document closes 

without a fuss. If you haven’t saved before closing, a dialog box appears, 

asking whether you want to save changes made to your artwork. To quit 

Illustrator, choose File➪Quit (Mac) or File➪Exit (Windows). If you haven’t 

saved before quitting, a dialog box appears and asks whether you want to 

save your changes. (Consistent good manners — aren’t they wonderful?)
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